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Micro Focus Academic Program 5.0 Release Notes
These release notes contain information that might not appear in the Help. Read them in their entirety
before you install the product.
Overview
The Micro Focus Academic Program brings contemporary software development tools and technologies to
COBOL development helping to bridge the gap between the old and the new.
COBOL applications still run many of the world’s business systems, therefore teaching the COBOL
language is a great way to prepare your university's students for a robust IT career in today’s economy.
The Micro Focus Academic Program is designed to support the education and use of the COBOL language
within the academic setting. This program supports our academic partner community through the use of
our COBOL development tools and materials within the classroom.
This program will enable your university to quickly join this growing league of similar academic
organizations in support of the promotion and education of the COBOL language.
Welcome! We’re excited to have you join our growing academic community.
Product Description
The Micro Focus Academic Program Edition package comprises the following products:
•

Visual COBOL - delivers the richest development experience for COBOL programming. On Windows,
Visual COBOL is available for use with Microsoft's Visual Studio or with the Eclipse integrated
development environments. On UNIX or Linux, it is available for use with Eclipse. Visual COBOL
supports the development and deployment of both JVM COBOL and .NET COBOL, and of native
COBOL applications.
Variants of Visual COBOL include:

•

• Visual COBOL for Visual Studio 2017 or Visual Studio 2019
• Visual COBOL for Eclipse (Windows)
Enterprise Developer - a contemporary development suite for Microsoft Visual Studio or for Eclipse that
enables mainframe developers to maintain, develop and modernize mainframe applications regardless
of whether these are to be deployed back on the mainframe or onto an alternative platform. Enterprise
Developer supports IBM COBOL, IBM PL/I, IBM Assembler, IBM CICS, IBM IMS, IBM JCL, IBM DB2,
IBM z/OS file formats and common batch utilities including SORT. This means you can develop and
maintain the core mainframe online and batch applications under Enterprise Developer, then deploy
them back on the mainframe or migrate them onto one of the Micro Focus production platforms
available on UNIX, Linux, or Windows. Variants include:
•
•

Enterprise Developer for Visual Studio 2017 or Visual Studio 2019
Enterprise Developer for Eclipse

Micro Focus Academic Program differs from the full version of these products in a number of ways. The
differences are:
•
•
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You cannot deploy applications on other machines, so Micro Focus COBOL Server and Enterprise
Server are not supplied.
An authorization code for the Micro Focus Rumba 3270 terminal emulator is not supplied.
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Note: Micro Focus Academic Program is supplied for Academic use only. It is not to be used for any
commercial purposes. You must be a registered Micro Focus Academic Program Partner in order to
use this software.
For more information, follow the link in the Electronic Product Delivery email for the End User License
Agreement.
Reporting Issues
•

For the latest information and discussions on this product, or to report issues, visit the Micro Focus
Community Web site.
Note:
•

•

This document contains a number of links to external Web sites. Micro Focus cannot be
responsible for the contents of the Web site or for the contents of any site to which it might link.
Web sites by their nature can change very rapidly and although we try to keep our links up-to-date,
we cannot guarantee that they will always work as expected.
Check the Product Documentation section of the Micro Focus SupportLine Web site for any
updates to the documentation which might have been uploaded.

Upgrading from earlier Micro Focus products
This version of your product is dependent on a later version of the Microsoft C run-time system than earlier
Micro Focus products. This means that COBOL executables (.exe) built with a version earlier than 4.0
might not be compatible with the current version of the run-time products. If the behavior of your application
changes with the current version, we strongly recommend that you relink the main executable with the
current version. This will ensure that the COBOL run-time system fully handles any run-time error
conditions that might occur.
A new executable that is fully compatible with the current version can be produced without recompiling the
application, as long as the original object code is available and it is relinked with the current version.
To allow your executables to benefit from the product's latest programming and performance
enhancements, we recommend a full recompilation of your source code.
If you are using Visual Studio, you can configure the IDE to automatically check whether applications
created with older releases must be relinked. If the application uses an older version of the C run-time
system, Visual COBOL can automatically relink the existing executable or .dll to the new version of the C
run-time system without the need to recompile the application first. If a project needs relinking, Visual
Studio displays a message in the status bar providing an option for you to choose and relink the project.
If you are using Eclipse, Visual COBOL can automatically relink existing projects created with Visual
COBOL earlier than 4.0 that have executable link artefacts. Eclipse displays a warning in the Problems
view that the project requires relinking. It then offers a Quick Fix action for you to execute that will link your
project with the most recent version of the Run-Time System.

What's New
This release provides enhancements in the following areas:
•
•
•
•
•
•
•

.NET Core Support
Amazon Web Services Quick Start for Enterprise Server
COBOL Formatting
Code Analysis
Enterprise Server and Scale Out Architecture
Enterprise Server Common Web Administration
Application Workflow Manager
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•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

AppMaster Builder
CICS Support
COBOL Language Enhancements
Compiler Directives
Consolidated Trace Facility
Data File Tools
Database Access
Database Connectors
Debugging
Eclipse Integration
Enterprise Server Security
Enterprise Server for .NET
IMS Support
JCL Support
Mainframe Access
Micro Focus Native Database File Handler
Micro Focus Rumba
Micro Focus Unit Testing Framework
PL/I Support
Platform Support
Product Documentation
Visual Studio Integration

.NET Core Support
Back to Top
Note: .NET Core on Linux is provided as an Early Adopter Product (EAP) feature only.
.NET Core is an open-source development platform that supports multiple operating systems. You can now
use Visual COBOL to develop a COBOL application then publish it to be deployed on .NET Core.
The following project templates for .NET Core applications are available - Class Library (.NET Core) and
Console App (.NET Core).

Amazon Web Services Quick Start for Enterprise
Server
Back to Top
Micro Focus has worked with Amazon Web Services (AWS) to create an AWS Quick Start for COBOL
Server. The Quick Start includes AWS CloudFormation templates and a deployment guide with step-bystep instructions that enable you to deploy Enterprise Server into a new or existing virtual private cloud
(VPC) on the AWS Cloud in about 1 hour and 15 minutes.
For full information see Micro Focus COBOL Server on AWS (click here).

COBOL Formatting
Back to Top
You can now reformat your COBOL code in the editor according to your preference and standards.
Formatting sets the indentation based on the configuration options which you can set in Tools > Options >
Text Editor > Micro Focus COBOL > Formatting > Indentation (for Visual Studio) and Windows >
Preferences > Micro Focus > COBOL > Editor > Formatter (for Eclipse).

6
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You can find the COBOL formatting features on the Edit > Advanced menu (for Visual Studio) and editor
context menu (for Eclipse) menu.

Code Analysis
Back to Top
You can now create the following views for your code:
•

•

Program Flow Graph - enables you to view the overall structure of the COBOL program with nodes
representing sections and paragraphs. PERFORM statements between them which affect the program
flow are represented by links joining the nodes. External calls to other programs are shown but cannot
be expanded in the Program Flow Graph view. Hovering over the nodes shows a tooltip containing the
code representing the respective sections or paragraph. Clicking a node or a link joining said nodes
positions the code editor to that point in the source, allowing quick and easy navigation of the program.
Data Flow Analysis Tree - enables you to select a data item and then either statically trace what might
change its value or what other data items it might affect.

Enterprise Server and Scale Out Architecture
Back to Top
Note: This feature is in Early Adopter Product (EAP) release status.
This release offers an enhanced and improved availability, and serviceability of Enterprise Server through
the ability to administer and maintain a cross-system group of regions as a single system image with the
new Performance and Availability Cluster (PAC).
In order for different Enterprise Server instances to be able to work together, they need to be able to share
data. This is achieved through the use of a Scale Out Repository (SOR). All ES instances in a PAC will
have a common SOR (PSOR) which is used to store CICS resources (limited to PCTs, PPTs, FCTs, DCTs
and TSTs in this release) as well as internal system data to facilitate synchronisation between instances.
Temporary Storage Queues and Transient Data Queues can also be shared between Enterprise Server
instances by directing them to a SOR. Benefits of using PACs and SORs in this way include:
•
•
•

•
•
•

Reduced hardware costs - taking advantage of the PAC to scale-out rather than scaling-up for more
efficient use of processor resources.
Easier maintenance - Dynamically adding or removing of regions to the PAC for system maintenance.
Increased availability - in the event of the failure of an Enterprise Server instance, the PAC can continue
to operate with reduced capacity. Enterprise Server instances can reside on different machines,
improving availability further.
Dynamic scaling - Enterprise Server instances can be added to, or removed from, the PAC depending
on demand.
Better performance - throughput is no longer restricted by the resources on a single machine (scale-up).
Improved serviceability - you can now administer the PAC and any associated regions as a single image
from a new contemporary web-based administration interface (ESCWA).

Enterprise Server Common Web Administration
Back to Top
Note: This feature is in Early Adopter Product (EAP) release status.
Visual COBOL now includes a new Enterprise Server Common Web Administration interface (ESCWA).
ESCWA is a web user interface and server for modern administration, monitoring and control of Enterprise
Server. It offers improved usability that consolidates the different Enterprise Server user interfaces so that
native and managed regions, and security stores can be managed in one place. Features include:
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•
•
•
•

•
•
•

Administering directory servers across multiple hosts.
Monitoring and control of CICS and JES Enterprise Server instances.
Configuring and administering a security store, defined in an LDAP-compatible security manager such
as Microsoft Active Directory or OpenLDAP.
Administering the Scale-Out features - enable you to specify logical groups of Enterprise Server
instances, and configure and run Performance Availability Clusters (PACs) and their related Scale-Out
Repositories (SORs).
Administering, monitoring and control of Enterprise Server for .NET regions and listeners.
The use of current web frameworks that have a greater focus on security.
(Included with 5.0 Patch Update 2 ) - support for Enterprise Server XA, MQ and PL/I configuration and
monitoring. This includes support for XA resources, configuring MQ, Listeners and Writers, PL/I, MFCS
console, Region Trace options, displaying the current ESMs on logon page and Local/loopback
connections warning changes.

Application Workflow Manager
Back to Top
Improvements have been made in the following areas:
•

Tools from the AWM, Eclipse, and ISPF Function Packages have been restructured and improved:
•
•
•
•

•

•

Tool parameters are now named so that the position of the parameter is not significant anymore.
You can only specify parameters which are supported by the tool.
Only the parameter types String and File are now supported.
Mass Processing is now an attribute of a tool parameter and is no longer a special input/output
parameter type.
• The tool relationship "Resource Operation Value" replaces the parameter type
"ToolDefinedResourceOperation".
A new REST Function Package has been added. It provides support for the following functions DELETE, HEAD, GET, PATCH, POST, and PUT.
The new JSON File Descriptor has been provided to support REST payloads. This function package
enables you to integrate RESTful API with your AWM workflow. See REST Function Package in your
product Help.
New tools in the Eclipse Function Package enable you to store and retrieve information from the Eclipse
secure store:
•

•

Save To Secure Storage; Read From Secure Storage; Delete From Secure Storage

You can use these tools to securely store login credentials to a remote system and reuse the
information for subsequent access.
A new attribute is now available to enable you to add comments to every model component in the AWM
model editor. See Comments in the AWM Model Editor in your product Help.

AppMaster Builder
Back to Top
The AppMaster Builder Data View Explorer tab has been redesigned in this release make it easier to
create and maintain data views. Features include:
•
•
•
•
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Creating SQL data views directly from the mainframe DB2 catalog
Creating IMS and VSAM data views without the requirement for a global DDIFILE
Generating data views using new DDIMETA files located in the DDIMETA folder in the AMB project
A data view import process is provided to create DDIMETA files from existing DDISYMB files
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CICS Support
Back to Top
Note: This feature is in Early Adopter Product (EAP) release status.
This release includes the following enhancements:
•

CRCN CICS transaction - this new in-built CICS transaction monitors the state of XA connections for
each resource manager (RM) entry defined in the system. If CRCN finds that connections have become
unavailable, it will attempt to reconnect at regular intervals. (The frequency of the monitoring is
controlled by the ES_XA_RECONNECT environment variable.) CRCN will emit messages to the
console to warn of connections lost and regained.

COBOL Language Enhancements
Back to Top
The following enhancements have been made to the COBOL syntax:
•

ISO2002 conditional compilation - an additional mechanism for conditional compilation, the ISO2002
Conditional Compilation method, is now available. This has been implemented as part of the support for
Enterprise COBOL 6.2.
The following compiler directing statements are supported:
>>DEFINE
>>IF/>>ELSE/>>END-IF

•
•
•
•

>>EVALUATE/>>WHEN/>>WHEN OTHER/>>END-EVALUATE
The JSON PARSE statement enables you to convert JSON text into COBOL data formats. This has
been implemented as part of the support for Enterprise COBOL 6.2.
Async and await syntax (.NET COBOL only) - support is available for asynchronous programming
in .NET COBOL using the async and await syntax.
INSPECT statement - the performance of INSPECT... CONVERTING has been improved, particularly
for cases where source-alphabet is long.
Support has been added for the portable syntax for SET - set[string].

Compiler Directives
Back to Top
The following Compiler directives are new in this release:
JVMTARGET

Specifies the JVM version number targeted by the class files generated in this
compilation unit.

ILNORMALIZENAMES Determines the program elements that are normalized when a program is
compiled to .NET or JVM COBOL. Normalization in this context results in
replacing all $ and - (hyphen) characters with _ (underscore) characters in the
name of the generated class file.

Consolidated Trace Facility (CTF)
Back to Top
This release provides the following enhancements:
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•

•

Availability of CTF from the Eclipse interface - a new property tab, CTF, in the Eclipse launch
configuration dialog box helps to enable CTF tracing and specify a CTF configuration file. By default, the
trace files are then saved in a Logs subfolder within the project's folder.
Dynamic CTF - it is now possible to configure the CTF dynamically from outside the process being
traced.
Using a new command line utility - cblctd - you can alter the tracing events of running applications
that already have CTF tracing enabled. You can alter trace levels, add or remove components to or from
the trace, and also configure the emitters in effect.
Additionally, there is also a new component that you can trace - mf.mfdbfh enables you to trace activity
of the Micro Focus Native Database File Handler.

Data File Tools
Back to Top
This release provides the following enhancements:
•
•
•
•
•

The Data File Editor now includes a Compare Files tool that enables you to compare the contents of
two data files side-by-side.
Structure files, and the layouts within them, can now be created within the Data File Editor; you no
longer need to use the Classic Data File Tools utility to manage your layouts.
When connecting to a VSAM dataset stored in an enterprise server region, you can store any
passwords required for access, for the duration of your current session.
You can view archived JES spool jobs that have been merged into one spool file using the merging
archived spool files process.
You can now quickly duplicate records in non-indexed files, using the Duplicate Record option.

Database Access
Back to Top
Enhancements are available in the following areas:
OpenESQL ADO.NET Connection Editor Toolbar
•

•

A new "i" (information) button is available that provides all the details of any installed .NET provider.
Provides additional information mitigating resource definition and use within the ADO.NET Connection
editor
Static XA switch modules "Reconnect" - At the beginning of a global transaction, the XA switch will
attempt to reconnect temporarily broken connections to the database. If there is a temporary disconnect
to the database, there is no need to manually re-enable the XA switch to run transactions.

Database Connectors
Back to Top
You can now create an identity column in your database by using a new XFD directive IDENTITY_COLUMN. This must be specified on a numeric field.

Debugging
Back to Top
This release includes the following enhancements:
•
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Animate - Eclipse now includes an additional menu option when debugging a COBOL program for
setting the speed and toggling Animate mode. When active, the program will automatically step through
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each line of source code, updating the source code in the editor, the Debug Stack, Outline and
Variables Views. See Debugging Commands and Options in your product Help.
•

COBOL Visualizer - a new window in Visual Studio enables you to view and edit a data item during
debugging in either text or HEX forms. You invoke the window from the DataTip for the data item.

•

Conditional watchpoints - you can now specify conditions and hit counts for COBOL watchpoints. A
condition can be in the form of an expression or it can be a hit count (for the number of times memory
associated with a data item has been updated). The condition is evaluated each time the data item
being watched changes. If the condition evaluates to true, then program execution stops. This enables
more fine-tuning of the current watchpoint support and is useful when debugging large, complex
programs.

•

Dynamic core dumps - you can now invoke a core dump programmatically and continue execution of
your program. A new library routine, CBL_CREATE_CORE, enables you to produce a core file for the
current process or a process owned by the same user that owns the current process.

•

Improved visibility of the PERFORM stack - the PERFORM stack and PERFORM range names are
visible in system debuggers such as gdb in many cases on 32-bit Linux with Intel architecture and
Solaris with Intel architecture. This was already the case on AIX, 64-bit Solaris-Intel, and all other Linux
platforms (including 64-bit Linux-Intel).

•

Live Recording - a new environment variable, COB_LIVE_RECORD_SIZE, is now available to aid
performance during the creation of a live recording file. Use it to specify the amount of memory (in MB)
that is to be used to store events that are to be written to the live recording file. When the limit is
reached, the buffer is cycled so that the oldest events are removed to make space for the most recent
events.

•

In order to include source line numbers in run-time error messages, which makes the diagnosis of
issues in your program easier, the COBOL compiler now produces .idy files by default when building
from the command line, unless the NOANIM directive is specified. You can safely remove .idy files
after compilation if you do not need them; they do not need to be distributed with your application unless
you want to debug your code. However, unless you specify the ANIM directive, generated executables
such as .dll and .gnt will not be debuggable, which is consistent with prior behavior.
Note: Behavior has not changed if you are using an IDE or build scripts generated by an IDE.

Eclipse Integration
Back to Top
This release includes enhancements in the following areas:
•

•

•

Supported Eclipse versions - this release supports Eclipse 4.7 (Oxygen) and 4.8 (Photon). The setup
file installs Eclipse 4.8.
Eclipse 4.6 (Neon) is no longer supported.
Java support - the 64-bit Java 8 is required to run the Eclipse IDE. The setup file installs Adopt
OpenJDK 8 (u202) with Hotspot. Java 8 (32 or 64-bit versions), and Java 11 (64-bit version only) are
supported for executing JVM COBOL code and for native COBOL and Java interoperability. For full
details on the supported Java versions, see Software Requirements in your product Help.
COBOL editor:
•
•
•

Automatic insertion of END statements - Eclipse now automatically inserts the end clause for IF,
EVALUATE, PERFORM, EXEC and TRY statements.
Automatic insertion of closing symbols - by default, Eclipse now automatically adds closing quotes
and brackets where required.
Search text positioned between specified columns - the Micro Focus Find/Replace dialog box now
includes options to search between specified columns in the code.

Micro Focus Academic Program 5.0 - Release Notes
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•

•

•

Directive sets - Compiler directives for your projects are now saved in language-specific .mfdirset
XML files stored within a .settings subfolder in the project's folder. You can create your own versions
of .mfdirset files and verify them against an XML schema that Micro Focus supplies.
Previously, all settings were stored in a single, proprietary IDE project file. Existing projects which
currently specify directives and other similar settings in the .cobolproj file will be upgraded to use the
new .mfdirset files when imported or loaded in Visual COBOL 5.0. If you are storing your source
code in a source control system, ensure that you add the .mfdirset files to source control as well.
Remote connections - support is available for automatic SSH tunnelling of network traffic. You can route
most network traffic using SSH port forwarding. This makes developing on a remote UNIX host running
a firewall easier to configure. In addition, the network traffic is encrypted as it is being sent within an
SSH tunnel. See To create a connection to a remote UNIX host running behind a firewall in the product
Help.
User Interface:
•
•

The COBOL Explorer view uses an icon overlaid with P to indicate COBOL programs that will not
be built because they are preceded by another of the same name on the build path.
Improved settings UI - the COBOL, IMS, and the Run-time Configuration settings pages now use a
property grid that also shows the definitions of the settings.

Enterprise Server for .NET
Back to Top
This release includes the following enhancements:
•

•

•

•

Improved CICS compatibility - CICS EIBRCODE handling in Enterprise Server for .NET now matches
the mainframe specification. CICS BMS support in Enterprise Server for .NET now matches the
behavior on the mainframe and in native Enterprise Server more closely.
MMC administration UI support for ESF security - the MMC snap-in for Enterprise Server for .NET
administration now supports the External Security Facility. This means you can use LDAP-based or
custom security solutions to provide administrator authentication and access control.
TLS (SSL) support - the seelistener utility now supports TLS (also known as SSL) for its TCP
communications channels. These include all channel types except MQ. The Enterprise Server for .NET
client classes also have been enabled for TLS. For example, the seeout utility can now be used with a
TLS-enabled MFBINP channel.
Performance improvements - this release comes with an improved performance in WCF, system
database operations, and VSAM database operations.

Enterprise Server Security
Back to Top
This release includes the following enhancements:
•

•

•

Security - security features can now be employed when developers and administrators install new
COBOL services (web services and EJBs) into an enterprise server instance over the network. There
are a number of authentication and authorization options that can be enabled. See Deployment
Listeners and The .mfdeploy File in your product Help.
Vault Facility - a new security feature has been added that enables some Enterprise Server components
to keep certain sensitive information in a form of storage defined as a vault, accessible via a
configurable vault provider. The default vault provider stores data in encrypted format on disk.
OpenSSL 1.1.1 - the OpenSSL security provider has been updated to OpenSSL version 1.1.1.
This is the stable Long Term Support version of OpenSSL.
•
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Added support for the ratified TLS protocol version 1.3. TLS 1.3 benefits include:
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•

•

•

•

•

Much shorter initial connection negotiation sequence. This reduces the time taken to establish a
link before starting to transmit data.
• Using only the most secure ciphers and hash methods.
• TLS 1.3 will be negotiated in preference to the older TLS protocols.
• Added support for new Ciphers and Key Exchange groups in line with TLS 1.3 requirements.
• The default security level for previously configured endpoints has been moved from Security Level 0
to Security Level 1. This removes the ability to accidentally make use of known-weak elements such
as SSL3 and MD5. Similar changes to the default Security Level have recently happened to Java,
Chrome, Firefox, and other systems providing secure connections.
Fileshare Security - the Fileshare Secure TCP/IP transport provider now supports the trusted use of
X509 certificates bearing the name of the Fileshare service as the Common Name element of the
certificate.
In previous releases, a secure connection to a Fileshare server was made using a certificate that
represented the network location upon which the Fileshare service was located. This method is still
supported, but does not distinguish between the exact Fileshare server that is being connected to when
more than one service can exist on a single host system. With this change, individual Fileshare services
can identify themselves by using a unique certificate. While running on the same host and registered
with the same network endpoint.
Support for Active Directory user groups and group name mapping - the Enterprise Server External
Security Facility's MLDAP ESM Module can now use Active Directory user group objects for Enterprise
Server user groups. Also, the module can now map long group names to the 8-character-maximum
names required for mainframe emulation.
Selective auditing - administrators can audit only security activity of particular interest, reducing audit
overhead and the volume of events. The Enterprise Server External Security Facility's MLDAP ESM
Module can now enable ESF Audit events only for particular users, groups, and resources.
Improved interaction with LDAP client libraries resulting in fewer LDAP-related issues and easier
diagnostics - the Enterprise Server External Security Facility's MLDAP ESM Module has improved
interoperation with LDAP client libraries:
•
•

•

The client library vendor and version information is logged after the library is loaded
The module has better heuristics for loading the correct library supplied by the OS vendor, so the
"provider" configuration option can generally be omitted
• For OpenLDAP, the module sets its proprietary "connect timeout" option
SNI support (requires 5.0 Patch Update 1 or later) - support has been added in Patch Update 1 for the
Server Name Identification (SNI) extension to TLS. This helps to avoid connectivity issues related to a
growing number of Web services being hosted on SNI servers.

IMS Support
Back to Top
This release includes the following new feature:
•

Checkpoint and restart are now available for output GSAM files in addition to input GSAM files.

JCL Support
Back to Top
This release includes the following enhancements:
•

Spool file housekeeping - you can now merge your archived spool files to a central location where they
can be viewed using the Micro Focus Data File Editor. This copies the archived spool files and merges
them into a new, combined archive. It does not change the original archive, so the audit trail remains
untouched, but the combined archive allows viewing of all the jobs that have been merged. The merge
process is carried out using a JCL job or by using a command line utility.

Micro Focus Academic Program 5.0 - Release Notes
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•

A new user exit MFJFAXIT - this user exit allows you to receive notifications when 'file open' events are
processed by the JCL engine. A sample exit can be found in the src\enterpriseserver\exits
sub-directory of your product install directory. You can enable this exit by using the MFJFAXIT
environment variable, to point to the exit program.

Mainframe Access
Back to Top
This release provides enhancements in the following areas:
•

•

•
•
•

•

Full support for the z/Server functionality - MFA Server now has the capability to service all z/Server
requests. This means it is no longer necessary to configure z/Server, and the number of started tasks
running on the mainframe is reduced. Installing and configuring MFA Server becomes easier as z/
Server is no longer required.
Browse dataset using IDCAMS dump - when using the MFDAS BROWSE command, it is now possible
to view the output of the IDCAMS DUMP command on the specified dataset in hex and printable
characters side-by-side.
Improved JES support for executing jobs and input datasets - it is now possible for MFA Server to
interact with JES jobs that are in executing phase, and to list and download input datasets.
Retrieve binder information for load modules - when executing the MFDAS BINDER command, it is now
possible to view the binder information from a load module.
TSO command server - MFA Server includes a new type of application server to support executing TSO
commands as the current user. The address space is spawned as your user id and any valid TSO
command can be executed.
UNIX sub-system (USS) support - MFA Server can now operate on files stored on a USS file system.
The available functions are - edit, browse, rename, delete, and copy USS files and directories.

Micro Focus Native Database File Handler
Back to Top
Note: This feature is in Early Adopter Product (EAP) release status.
The Micro Focus Database File Handler (MFDBFH) is a file handler that enables your native CICS and
batch enterprise server applications to interact with data files and certain infrastructure files stored within a
database.
VSAM files may experience logical and/or physical corruption in the event of a hardware failure. This is due
to a single COBOL I-O operation consisting of multiple physical I-O operations. If all the physical I-O
operations that make up the COBOL I-O operation are not performed, the file can be left without integrity.
In previous releases you could guard against such occurrences with Fileshare and logging, but they
required some manual intervention and came with performance cost.
In this release, configuration options have been added that allow the I-O operations to be routed to an
RDBMS to take advantage of the availability and performance characteristics of the database. This can be
achieved with no changes required to the application. The file will be routed to the SQL database simply by
changing the filename prefix to sql://.
Features include:
•
•
•
•
•

14

CICS and batch Cobol file I-O can now be routed to an RDBMS with only simple configuration changes.
No application changes are required.
Supports all Micro Focus file formats
Files can be routed to an RDBMS on a file by file basis.
Utilities are provided to enable data to be moved between disk files and RDBMS.
Support for PostgreSQL 10.x, Amazon Aurora PostgreSQL, Db21, and MS SQL Server (on Windows
and Linux Intel)
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Micro Focus Rumba
Back to Top
This release comes with Micro Focus Rumba+ Desktop version 10 which you can choose to install with
Visual COBOL. This will enable embedded Rumba support within the IDE.

Micro Focus Unit Testing Framework
Back to Top
This release provides support for the following functionality:
•
•
•

Data-driven unit tests - a new type of test suited to testing data where values read from a source are
passed through the same tests.
JCL unit tests - two types of test that interact with the JES engine on an enterprise server region. These
tests are run from the command line.
Test output colorization - test output can now include basic colorization for supported terminal
emulations. This feature must be run from the command line.

PL/I Support
Back to Top
Enhancements are available in the following features:
•
•

Code coverage in Eclipse - code coverage data can now be generated for PL/I programs in the Eclipse
IDE using the same mechanisms as for COBOL programs.
Compiler:
•
•

Full support for GET DATA.
Built-in functions:
•

•
•
•
•
•
•
•
•
•
•
•
•
•
1

New built-in functions - ALLOCATE, INDEXR, MEMCONVERT, MEMINDEX, ONCONDCOND,
PLIFREE, REM, REPLACEBY2
• The HEX built-in function now matches its z/OS version.
• The PROCNAME and PROCEDURENAME functions used without trailing open/close parents.
Allow the use of VALUE to initialize members of a PL/I Data Structure.
Support for INONLY, NONASSIGNABLE attribute.
Diagnostics when a supplied parameter to a call is larger than the entry declaration.
Diagnostics when the Compiler detects that a loss of precision occurs as a result of operations on
FIXED DECIMAL operands.
Compiler listings now provide additional information about arrays.
OPTIONS(REORDER) is now parsed but ignored.
*PROCESS OPT(TIME); is now supported.
Support for larger concatenations when initializing variables or making assignments.
Support for named constants of numeric PICTURE type in static structure dimensions and
initializations.
Diagnostics when the concatenation of two strings results in a string that is larger than the target
variable.
Support for the DUMMY ALIGNED and DUMMY UNALIGNED arguments.
Support for the XML case asis and XML case Upper.
Diagnostics if code attempts to use bitwise operators on non-bit variables.

Db2 support was introduced in the 5.0 Patch Update 2 release
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•

•

(Added in 5.0 Patch Update 1) A new option, –fdmaxp 15,31, has been added. With this one
specified, arithmetic operations with fixed decimal operands with precision <= 15 produce a result
with a maximum precision of 15. For arithmetic operations with fixed decimal operands with precision
<= 31, they produce a result with a maximum precision of 31.

The options –fdmaxp 15,15 and –fdmaxp 31,31 are allowed, and correspond to –fdmaxp 15 and –
fdmaxp 31, respectively.
PL/I debugger in Eclipse:
•
•

•
•

Variables surrounding current point of execution now displayed in Variables view.
A Console view for PL/I programs that are being remotely debugged outside the control of Enterprise
Server, and in Eclipse.
• Data watchpoint setting using a variable declaration in the debugger.
• PLIDUMP now emits STATIC variables in addition to AUTOMATIC and Parameters when
documenting the callstack.
The Macro preprocessor now supports %INSCAN and %XINSCAN.
The EXEC preprocessor now supports the following:
•
•

•

SQL statements embedded within PL/I packages
The -maxmsg option for setting the maximum number of errors to be generated before terminating
the compilation
• Up to 4000 include files in a signal program
PL/I Run-Time System - support is now available for:

•
•
•
•
•

Optionally generating Windows "Mini-Dumps" or a Linux coredump off the back of a call to
PLIDUMP.
Dynamic allocation of datasets using the TITLE option(s).
Raising an ERROR condition when a called subroutine raises a COBOL RTS error.
FILE variables can have differing DCB when used in differing contexts.
STATIC FIXED BIN(31) variable accessed at open within the RECSIZE() attribute of the
ENVIRONMENT.

Platform Support
Back to Top
Support is now available for the following additional or updated operating systems:
•
•
•

SUSE (Power) 11 SP3, 12
Red Hat (Power) 7.2, 7.3
Windows Server 2019

For a full list of supported platforms, check HTTPS://SUPPORTLINE.MICROFOCUS.COM/
PRODAVAIL.ASPX.

Product Documentation
Back to Top
The following is new in this release:
•

•
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Online context help in Visual Studio - online context Help is now the default setting for Visual COBOL
and opens the documentation available on Micro Focus SupportLine.
Visual COBOL local help is still supported and can be installed manually, if required. See After Installing
in the product Help for details.
The Comparison of COBOL with Other Managed Languages document has been updated to reflect the
recent enhancements in the .NET and JVM COBOL support.
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Visual Studio Integration
Back to Top
This release includes enhancements in the following areas:
COBOL editor:
•
•
•
•
•

•
•

Code snippets - new snippets are available for $if and $region statements, and for specifying
*cblformat off which indicates the area of code that is unaffected by formatting.
Collapsible regions - outlining is now available for IF, EVALUATE and PERFORM statements.
Peek Definition context menu command - this invokes a pop-up window, embedded in the editor,
showing the data item definition. You can use the feature both while editing and while debugging.
IntelliSense suggestions - IntelliSense suggestions for the COPY statement now include directories to
add.
(Introduced in 5.0 Patch Update 1) Choosing a separator for qualified field names - you can configure
IntelliSense to either use OF or IN as a separator in qualified field names - e.g. A-COUNT OF AWORK-1 or A-COUNT IN A-WORK-1. You can specify this in Tools > Options > Text Editor > Micro
Focus COBOL > IntelliSense, and on the Completion Lists page.
Find All References - the Find All References output window for COBOL has been enhanced, so you
can now filter results, group results, order results and search results.
Quick actions - the editor now displays light bulbs for creating a missing section or a paragraph, for
adding and sorting $ILUSING statements, and for removing or commenting out dead code.

Visual Studio tool windows:
•
•

The Error List window now includes a column for the Sequence Number.
You can use Visual Studio's Find All References tool window to search for references in your COBOL
projects.

New settings in the project property pages:
•
•

The Debug project properties page for managed projects now includes settings for either generating a
portable symbol file (.PDB) or for embedding the portable symbol information directly in the assembly.
The Smart Linkage section in the properties of managed projects now offers two new settings for
enabling the ILSMARTTRIM and ILSMARTANNOTATE Compiler directives.

New project template categories:
•

The COBOL project templates are organized in a new set of categories that better represent the tasks
and workloads used in modern development. Some of the categories, such as Azure or .NET Core, only
show if you have installed the support for these features in Visual Studio. For more information, see To
install missing features from the IDE in your product Help.

Significant Changes in Behavior or Usage
This section describes significant changes in behavior or usage. These changes could potentially affect the
behavior of existing applications or impact the way the tools are used.
Where present, the numbers that follow each issue are the Support Incident Numbers followed by the
Reported Problem Incident (RPI) number (in parentheses).
•
•
•
•
•

Common Communications Interface
Communications Server
Compiler
Data Tools
Documentation
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•
•
•
•
•
•
•
•
•
•
•
•
•
•

Eclipse IDE
Enterprise Server
Enterprise Server Auditing
Enterprise Server for .NET
File Handling
HCO for SQL Server
IMS Support
JCL Support
Mainframe Access
Micro Focus Batch Scheduler Integration
Micro Focus Directory Server
MFCRYPTLIB
PL/I Support
Request Packet Interface API

Common Communications Interface
Back to the list
•
•

•

•

Certificate subject names are now correctly checked against the name the client is attempting to
connect to. Certificates registered to "localhost" should now work as expected.
The default Cipher Suites List now includes @SECLEVEL=0. This indicates that backwards
compatibility with old certificates such as MD5 is to be retained. As a result of this change, you need to
review your use of the Cipher Suites List and of any old certificates.
If using Micro Focus Common Client(MFCC) or Micro Focus Communications Server(MFCS) to connect
to a non-existent remote host, it was possible to create a connection to a server listening on the same
port on the local system. This is no longer possible and a bad address error is reported in the error logs.
By default, in this and previous releases an SSL/TLS CCI client can trust a server which resides on an
IP address that is not an intended connection target. You can now specify the ssl_only_verify_literally
option in your CCI.INI file to restrict the certificate check to improve security. See “CCITCP Security
Options in the CCI.INI File” in your product Help for more information. When connecting to a non-CCI
protocol server, all clients perform strict certificate checking as the new default behavior

Communications Server
Back to the list
•

Passphrases specified in the mf-server.dat file can now contain spaces.

•

2832222 (1100976)
Configuring MFCC when run under MFCS now works as expected.

Compiler
Back to the list
•

The Search order has been updated, to allow the Compiler to find Java.

Data Tools
Back to the list
•

Accessing a dataset through the Data File Editor now obtains a shared lock on Enterprise Server when
you open the file in shared mode.
3170479 (1115346)
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Documentation
Back to the list
•

The ANIM Compiler directive has changed its default when compiling from the command line on
Windows platforms. The default is now ANIM. (Compiling from the IDE still defaults to ANIM.)

•

The validation of server certificates for TLS (also known as SSL) connections has been corrected. This
is likely to cause connection failures in cases where previously connections were incorrectly allowed.
For example, if Fileshare is secured with TLS, client applications must be configured to use the
hostname of the Fileshare server as it appears in the server's certificate. If the Micro Focus Directory
Server is secured with TLS, then MFDS clients, such as the casstart command-line utility, will need to
connect to it using a hostname that appears in the certificate MFDS is using. (Note that a certificate can
contain multiple hostnames.) Consult your Certification Authority administrator for more information.
3192497 (1117068)

Eclipse IDE
Back to the list
•

•

•

•

•

•

In the Expressions view, there has been a change to the way that the number of characters displayed is
controlled. The Hex part now always displays the same number of characters as the raw data part (note
that Eclipse enforces the character limit, so the number entered by the user will include those used to
display the hex values). A maximum length entry of 0 is now correctly interpreted as "no limit".
3161694 (1114658)
Eclipse now colorizes files that it will not build because they are preceded by other files of the same
name on the build path. The icon of such files is overlaid by an I or P and Eclipse shows a tooltip with
an explanation. This is to clarify the difference between this scenario and build-action-ignored.
3161416 (1114607)
Micro Focus Find/Replace now provides a Column Scope group that enables you to limit searches
between columns. You can specify columns or alternatively you can search only in the main code area
for the file type open in the editor. By default, it searches in all columns.
3142899 (1112931)
Compiler directives are now stored in .mfdirset files which can be specified for particular languages, at
project/config/folder/file level.
2853665 (1104556)
By default, COBOL, COBOL JVM, and Mainframe COBOL Projects have the EXITPROGRAM"ANSI"
directive set in the Project Settings > COBOL Properties. This specifies that if the EXIT PROGRAM
statement is executed in a program that is not under the control of a calling program, it causes
execution of the program to continue with the next executable statement. See EXITPROGRAM in your
product Help for more information.
The COBOL JVM method breakpoint can now be toggled on the heading of the method.

Enterprise Server
Back to the list
•

A number of audit events now contain some additional information.
3140310 (1112666)

•

•

Previously, the /x option of the CASRDTEX utility had been duplicated to drive XML output. This
prevented the export of transactions which was the original meaning of /x. To generate an XML export,
you must now specify the option /xm.
3180233 (1116108)
casfhsf could hang when processing HSF files that contain records from tasks that ran in different
months.
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•

•

3177385 (1115884)
A new system transaction, CRCN, is now available to monitor the state of XA connections for each
resource manager (RM) entry defined in the system. CRCN is a replacement for the former XA
Reconnect facility that recycled SEPs on connection loss. The XA Reconnect facility was configured by
setting the ES_XA_RECONNECT environment variable. CRCN also uses this environment variable,
although its usage differs slightly. For more information see your product Help.
3174272 (1115727)
On Windows, any casout and cassub messages are displayed on cassub and casout API invocation if
the environment variable ES_CAS_API is not set to "ON".
3160400 (1114458)

•

•

A new environment variable, ES_SNATRC_DIR, is available for configuring the location of the SNA
traces written by IMB's communication manager. To ensure that the SNA trace files are written to a valid
directory, ES_SNATRC_DIR must be set before you start the region.
3173516 (1115523)
When defining CICS term in ESMAC, if the terminal definition includes a user ID, Enterprise Server
honors the terminal user ID, and you can leave the User ID field blank. Caution: When the terminal
definition includes a user ID, this logs you into the terminal without password verification. Use with care!
3158468 (1114309)

Enterprise Server Auditing
Back to the list
•

Auditing on big-endian platforms now correctly interprets numeric audit data.

Enterprise Server for .NET
Back to the list
•

The system has been improved so that in a scale-out work is more likely to be distributed evenly among
SEP pools. There is now a configurable time limit for SEPs to continuously retrieve work, after which
they will distribute the next task to a different SEP. This time limit is controlled by the
ContinuousTaskProcessingTimeLimit key in seesep.exe.config, or in the WAS SEP Web.config
file. In order to take advantage of this change, there must be a load balancer between the monitor and
the dispatcher, to ensure work is distributed evenly between dispatchers.

File Handling
Back to the list
•

RELFORMAT=MF|RM is now enabled for FOLDER and other filename tags.

•

3164916 (1114803)
The SORT-CONTROL special register is now supported during a SORT statement.

•

3159740 (1114389)
To direct the handling of relative files to a particular file handler (either MF COBOL or RM/COBOL), use
the RELFORMAT=MF or RELFORMAT=RM configuration options within the [REL-DEFAULT] tag of the
EXTFH.CFG file. (The default is RELFORMAT=MF.)
3157247 (1114149)

•

The FORMAT parameter is now correctly ignored when the format is explicitly set in the Include
statement. Also, an error is now returned if a numeric item is compared with a quoted value in an
Include statement.
3186371 (1116564)
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•

•

For MFJSORT, the SORT-EBCDIC instruction is now supported through the PARM parameter of an
EXEC statement.
3165343 (1114824)
When reading continuation lines from SYSIN for MFJSORT, if line 1 breaks at column 71 with a
nonblank in column 72, and columns 2-15 of line 2 are blank, DFSORT continues on line 2 with
whatever character it finds in column 16 (blank or nonblank).
3159842 (1114565)

HCO for SQL Server
Back to the list
•

HCOSS DB2 schema extraction has been updated to use the DB2 system default of EBCDIC SBCS
CCSID <value> for DB2 columns in tables with a CCSID value of 0 (zero, CHAR family types). This has
been done to appropriately handle the CCSID value for tables created using DB2 version 8 or earlier,
and that have been migrated to a newer version of DB2. In addition, HCOSS DDL generation maps
Euro collection sequences to the nearest match to a supported SQL Server collation sequence.
3163636 (1114937)

IMS Support
Back to the list
•

•

A performance delay that occurred when rapidly writing checkpoint records to the IMSLOGR file has
been corrected by updating the method used to verify the uniqueness of the timestamp in the key.
3131126 (1112901)
The IMS Support feature has been updated to support checkpoint/restart for output GSAM processing.
3107543 (1109558)

JCL Support
Back to the list
•

•

If the catalog properties of a data set are updated using MVSCATPB, and the data set is not opened
during the JCL step it is assigned to, then the updated catalog properties are not written at the end of
step disposition processing.
3186942 (1116611)
When security is enabled and a JCL job includes either JOBLIB or STEPLIB entries, the system now
checks that the user has READ access to each of the Partition Datasets (PO). If the user does not have
the required access, the job abends with a COND CODE of S913.

•

3176759 (1115814)
The DATACLAS and MGMTCLAS attributes are now applied to a DATASET when it is added to the
catalog and SMS support is enabled (MF_SMS=ON).

•

3174534 (1115630)
The DSNRLI reason-code value will be hexadecimal 0x00000000 when the return-code is zero. This is
a change from the previous value of decimal zero, '0000'.

•

3171133 (1115344)
MFFTP quote handling has been reworked to support IBM behavior. Filenames that contain spaces are
now required to be defined within double quotes ("). This change is required to support mainframe
hosted files, where single quotes (') will no longer append the user ID to start of the filename as the first
node.
3168300 (1115058)
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•

•

•

•

•

•

•

If JES security is enabled, when a JCL job is submitted that uses a PROC or INCLUDE file that is part
of a cataloged Partitioned Dataset (PO), READ access for the dataset will be checked, and if the user
does not have permission to read the dataset then an error will be reported.
3166921 (1114955)
When restarting a job, the COND CODES for steps prior to the restart step will not be evaluated. This is
a change in the behavior where previously the values of the COND CODES from the previous run was
checked. You can revert to the old behavior by setting the environment variable
MFJ_ALL_STEP_CHECK=Y.
3163358 (1114688)
The Spool Housekeeping history file, INDEXO, can now support 7-digit job numbering. A conversion
utility, MFHKHCOV, is supplied to convert any existing dataset to the new format. Run this utility using
the sample JCL job CONVERT.JCL. Once converted, the newly formatted dataset supports both 5- and
7-digit job numbering. If you only use 5-digit job numbering, you do not need to run the conversion. See
the 'MVSSPLHK Spool Housekeeping Process' section in the Help for more information.
3162868 (1114648)
When performing an IEBCOPY to a partitioned data set (PDS), a check is now made to ensure that the
user has DATASET ALTER permission for the PDS.
3159837 (1114347)
The DSNRLI functionality for the TERMINATE THREAD call has been improved so that it now calls
tx_end and then tx_close for a particular XA resource. A ROLLBACK call will not be issued prior to the
tx_close. If an error is returned from the tx_end function, it is reported back to the calling program as
return code 12, reason code 0X00F30093.
Missing and incorrect key values in the MF_JCL_AUDIT event output have been corrected. Also, the
audit event code resulting from MF_JCL_AUDIT has also been changed from '2 1' to '5 5' to avoid
conflict with the same code being used by other components.
For RISC-based systems when running JCL jobs, you might need to set COBMAINSTACK to a high
value such as 8000000.

Mainframe Access
Back to the list
•

By default, VSAM files whose average LRECL are the same as the maximum LRECL are now treated
as Variable when generating a .PRO file. You can override this with the existing /FIXEDVSAM flag, or by
specifying a fixed VSAM import type (ESDS-FIXED, KSDS-FIXED, or RRDS-FIXED).
3181871 (1116216)

•

SyncMon2 now uses the Endevor "Source Date" and "Source Time" information to determine if a file
has changed since the last synchronization.
3177475 (1115904)

Micro Focus Batch Scheduler Integration
Back to the list
•

When using MFBSI, the message JES000020W (JOB number warning percentage exceeded) is now
correctly handled, and no longer results in an invalid MFBSIJCL 208 return-code (JCL error).
3186963 (1116620)

Micro Focus Directory Server
Back to the list
•
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The event codes for several MFDS audit points have changed.
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•

On Windows, by default, the Enterprise Server Administration Web interface can only be contacted
using the loopback address (localhost or 127.0.0.1). You can enable remote access to the Web
interface by turning off the loopback mode. See "Using the Loopback Address" in your product Help for
more information.

MFCRYPTLIB
Back to the list
•

Passing an incorrect keyfile passphrase no longer results in receiving an RTS115 error in MFDS.
3181743 (1116186)

PL/I Support
Back to the list
•

A problem with allocation of BASED, CONTROLLED, and AUTOMATIC structures has been corrected.
This problem was limited to structures where the last member field was of type BIT. Specifically, the
problem only occurred for BASED, CONTROLLED, and AUTOMATIC structures when the last member
field is of type BIT, resulting in incorrect code generation for BASED and CONTROLLED storage at the
point of allocation (i.e., an ALLOCATE statement), and for AUTOMATIC storage, incorrect stack frame
allocation for the declared structure. Naturally, any module affected by this problem needs to be
recompiled. To ensure that no problems arise, the user should identify all modules that use a structure
or structures where the last member is of type BIT, and recompile those modules. This applies to users
who have compiled code with versions of Enterprise Developer earlier than ED 4.0 HF 10. Note: BIT
means a bit-string of any length, including BIT(1). It does not apply to BIT ALIGNED.

•

3192381 (1117048)
The Open PL/I compiler now generates a W-Level diagnostic if a constant array dimension or extent is
of type CHAR or BIT. This is usually unintended coding.

•

The macro preprocessor now supports the use of %INSCAN and %XINSCAN.
2880348 (1107310)

•

•

Previously, if a condition prefix for STRINGRANGE was enabled and a STRINGRANGE condition
occurred, it was raised to ERROR after being processed. This no longer occurs.
3182428 (1116254)
PLISAXA, PLISAXB, and PLISAXC processing has been enhanced to use ENTRY LIMITED functions
and procedures which utilize OPTIONS(BYVALUE).
3150969 (1113745)

•
•

A problem causing the SQL pre-compiler to hang has been fixed.
3165345 (1114825)
SQL is now supported in a PL/I PACKAGE. A SQLCA declaration (usually via include of SQLCA) in a
nested block (PROCEDURE or BEGIN)is not allowed. It is allowed only in the outermost block(s) or in a
PACKAGE.
3159844 (1114355)

•
•

The PL/I Eclipse debugger now supports double-clicking in the left margin on a DCL line to set a watch
on the variable for the content to change during execution.
The PL/I Eclipse debugger now supports displaying the current value of a variable by placing the cursor
over a variable name in the PL/I source.

Request Packet Interface API
Back to the list
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•

The default behaviour for TLS certificate Common Name (CN) matching has changed for release 5.0. It
now requires a strict match on the CN value or any Subject Alternate Name (SAN). For example,
127.0.0.1 and localhost are no longer implicitly equivalent, nor are hostname and its IP address or fullyqualified domain name (FQDN) variants. When starting a region from the Enterprise Server
Administration Web interface, a resolved IP address is used for the casstart -m parameter value. A
resolved IP address is also used even if a hostname is specified on a command line startup.
To change this behavior and use a resolved hostname value (as determined by the machine TCP
configuration, for example, hosts file entries.) set the environment variable MFDS_DNS_RESOLVE=Y.
To use an unresolved string literal hostname, for example, a value explicitly passed in via the casstart –
m command line parameter, set MFDS_DNS_RESOLVE=N.
3194613 (1117203)

Known Issues
Refer to the Known Issues and Restrictions topic in the Product Information section of your product Help.
In addition, note the following:
•

If you have Visual Studio 2019 16.0 installed, the Create a new project dialog box does not list COBOL
or PL/I in the Language field. You can find the COBOL and the PL/I project templates, by searching for
either COBOL or PL/I using the search field.
To resolve this problem and make the COBOL and PL/I categories visible in the Language field, you
need to install Visual Studio 2019 version 16.1 or later.

•

On Linux, the marketplace client in the supplied version of Eclipse will not work correctly if the product is
installed in a spacey directory. Micro Focus recommends that you avoid installing the product in a
spacey directory on Linux, if you want to install any additional plugins from the Eclipse marketplace.

•

The COBOL editor might show incorrect error messages for a linked resource with file-specific COBOL
settings as the file settings are incorrectly ignored.

•

When breakpoints have previously been set in a remote PL/I program in Eclipse and a new debugging
session is started for a local PL/I program, the debugger will crash. The same issue occurs if previously
set breakpoints are present on a local PL/I project and a remote debug session is started.
To work around this you need to clear all previously set breakpoints in remote (local) projects before
starting a local (remote) debugger session. You can remove the breakpoints from the Breakpoints view
in the Debugger perspective.

Installation
System Requirements
Hardware Requirements
In general, most modern machines will have the required processor and available RAM to run the Micro
Focus products under Windows effectively. For planning purposes, you should consider having a minimum
of 2GB of RAM though Micro Focus recommends at least 4GB of RAM for optimal performance.
Visual COBOL and Enterprise Developer for Visual Studio
Visual COBOL and Enterprise Developer have the following requirements in addition to the requirements of
Microsoft Visual Studio. See the Visual Studio documentation for details of the Microsoft requirements.
The disk space requirements are:
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Product

Maximum Disk Space
Requirements

Sentinel RMS License Manager

Visual COBOL

1.2GB

75MB

Enterprise DeveloperEnterprise
Developer

2.3GB

75MB

Note: This includes the space needed to cache information locally so that you can modify the
installation without the original source media.
Visual COBOL and Enterprise Developer for Eclipse on Windows
The disk space requirements are:
Product

Maximum Disk Space
Requirements

Sentinel RMS License Manager

Visual COBOL

3.7GB

75MB

Enterprise Developer

4.5GB

75MB

Note: This includes the space needed to cache information locally so that you can modify the
installation without the original source media.

Operating Systems Supported
Note: If you are using Visual COBOL or Enterprise Developer on a 64-bit operating system, you can
produce either 32-bit or 64-bit applications.
For a list of the operating systems each individual product in this package supports, check the Product
Availability section on the Micro Focus SupportLine Web site: http://supportline.microfocus.com/
prodavail.aspx.
•

Visual COBOL for Visual Studio is not supported on versions of Windows earlier than Windows 7.

Software Requirements
Note: This product includes OpenSSL version 1.1.1b.

Windows
Note: The setup file will check your machine for whether the prerequisite software is installed and will
install any missing prerequisites and the product components.
Visual COBOL and Enterprise Developer for Visual Studio:
You must have Microsoft's Visual Studio 2017 version 15.9.4 or a newer one or 2019 version 16.0 or a
newer one installed in advance.
You need one of the advanced versions of Visual Studio listed below:
Professional, Enterprise or Community Edition (for Visual Studio 2017) - see the next section for the
Visual Studio components you must install.
Professional, Enterprise or Community Edition (for Visual Studio 2019) - see the next section for the
Visual Studio components you must install.
Microsoft's Visual Studio Express Edition is not supported.
Visual COBOL and Enterprise Developer for Eclipse:
The following requirements apply to both Visual COBOL and Enterprise Developer:
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•

•
•

The setup file installs Visual COBOL and the 64-bit Eclipse 4.8.
Some earlier versions of Eclipse are also supported. See Installing Visual COBOL into other instances
of Eclipse in the Advanced Installation Tasks.
Visual COBOL installs fully only on 64-bit Windows platforms. On 32-bit Windows, the setup file does
not install some of the components. See Issues with the Installation in Known Issues and Restrictions.
Visual COBOL supports both the 32-bit and the 64-bit Eclipse. You can use the 64-bit Eclipse to create
both 32-bit and 64-bit applications.

The setup file will check your machine for whether the prerequisite software is installed and will install any
missing prerequisites and the product components.
•

Java 8 (64-bit) is required to run the Eclipse IDE. The minimum recommended version is
AdoptOpenJDK's OpenJDK 8 (u202) with Hotspot, which the Windows product installs automatically.
Java 8 (32 or 64-bit versions), and Java 11 (64-bit version only) are supported for executing JVM
COBOL code and for native COBOL and Java interoperability. You can download AdoptOpenJDK's
OpenJDK 8 with Hotspot from AdoptOpenJDK's Web site and unpack the archive anywhere on your
machine.
Note: Eclipse does not run using Java 11.

•

Visual COBOL requires:

•

• A 32-bit Java installation if using the 32-bit Eclipse.
• A 64-bit Java installation if using the 64-bit Eclipse.
The setup file also installs Microsoft's Visual C++ 2012, 2013 and 2017 Redistributables.

Installation Restrictions and Requirements
Before starting the installation you should be aware of the following:
•
•
•

•
•

Visual COBOL and COBOL Server cannot coexist on the same machine.
Visual COBOL and Enterprise Developer cannot coexist on the same machine regardless of which IDE
(Visual Studio or Eclipse) you install.
You need to be logged in with a user-ID that has write access to the registry structure under
HKEY_LOCAL_MACHINE, HKEY_CLASSES_ROOT, and HKEY_CURRENT_USER so the installation
software can set the environment appropriately. You also need to be logged on with Administrator
privileges.
If you are installing this as an upgrade, make sure that none of the product files are in use when you
start the installation. Also, the Visual Studio Help Viewer must not be opened.
You need to be logged in with a user-ID that has write access to the registry structure under
HKEY_LOCAL_MACHINE, HKEY_CLASSES_ROOT, and HKEY_CURRENT_USER so the installation
software can set the environment appropriately. You also need to be logged on with Administrator
privileges.

Downloading the Products
1. Use the download links in your Electronic Product Delivery email.
For more information follow the links for the installation instructions and the End User License
Agreement.

Installing the Products
Use the individual setup files to install each product from the Micro Focus Academic Program package as
follows:
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Windows
1. Run the productname.exe file and follow the wizard instructions to complete the installation.

After Installing
Visual COBOL and Enterprise Developer for Visual Studio
You are now ready to run Visual COBOL or Enterprise Developer. From the Windows taskbar click Start >
All Programs > Micro Focus Product Name > Product Name for Visual Studio. (The Start menu is not
available on Windows 8, Windows 8.1, and Windows Server 2012. You use the Start screen to invoke
programs.) By default, the Help is available online on the Micro Focus SupportLine Web site: https://
www.microfocus.com/support-and-services/documentation/.
To see the Help:
1. Either click Help > View Help or press F1 inside the IDE.
This opens the Visual COBOL help or Microsoft's MSDN depending on which keyword in the editor or
part of the UI you are querying.
Note: Your Visual Studio might be configured to show the local help. To switch to online help, click
Help > Set Help Preferences > Launch in Browser inside Visual Studio.
Refer to the Start Here and Product Information sections in your product Help. Here, you will find
information on getting started including tutorials and demonstration programs.
Visual COBOL and Enterprise Developer for Eclipse
If you have used Eclipse from the same workspace before, the Eclipse perspective settings are not reset
after installing any Micro Focus product. To pick up any new features, you must reset the perspective you
are working with after installation:
1. Open the existing workspace with this product.
2.
3.
4.
5.
6.
7.

You may receive some warnings or errors which you can ignore.
Make sure you are in the perspective you need to reset by clicking Window > Perspective > Open
Perspective > Other.
From the Open Perspective dialog box, click the perspective you want to reset.
Click OK.
Click Window > Perspective > Reset Perspective.
When prompted, click Yes.
Reapply any customizations.

Installing X Windows on Windows
Some features of Visual COBOL for Eclipse and Enterprise Developer for Eclipse on Windows require an X
Windows installation, so Micro Focus ViewNowX is provided with the product. To install, run the file
ViewNow_X_Server.exe in your Visual COBOL installation. By default this will be in the
%ProgramFiles(x86)%\Micro Focus\Visual COBOL\ViewNowX folder.
ViewNowX requires that your client machine has Microsoft Visual C++ 2008 SP1 Redistributable Package
(x86) installed. If it is missing from your machine, the ViewNowX installation will offer a link to download the
package.
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Repairing
Windows
If any product files, registry settings or shortcuts are accidentally removed at any point, you can perform a
repair on the installation to replace them.
To repair your installation on versions of Windows Vista or later:
1. From the Control Panel, click Uninstall a program under Programs.
2. Right-click your Micro Focus product and select Repair.
UNIX
If a file in the installation of the product becomes corrupt, or is missing, we recommend that you reinstall
the product.

Uninstalling
Windows
To uninstall the product, you cannot simply delete its files from your hard disk. To uninstall the product:
1. Log in with the same user-ID as you used when you installed the product.
2. Click Uninstall a program under Programs in Control Panel.
3. Select the product and click Remove or Uninstall as appropriate.
When you uninstall, the only files deleted are those that the installation software installed. If the product
directory has not been removed, delete any unwanted files and subdirectories within it using Windows
Explorer.
Note: The installer creates separate installations for Visual COBOL, Enterprise Developer, Enterprise
Server for .NET, and Micro Focus License Administration. Uninstalling only Visual COBOL does not
automatically uninstall Enterprise Server for .NET, the Micro Focus License Manager or any of the
prerequisite software.
Enterprise Server for .NET must be uninstalled before you remove Visual COBOL. To completely
remove the product you must uninstall the Micro Focus License Manager as well.
You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.
Some registry entries are not removed by the uninstallation process and you need to manually delete
them.
The following folders might not be removed:
•
•
•
•

Micro Focus Product Name folder in the Start menu - you can delete it manually.
%systemdrive%\Users\Public\Documents\Micro Focus - includes the binaries and the log
files of the samples which you have built.
%ProgramData%\Micro Focus - includes some data files used by the Micro Focus licensing system.
%Program Files%\Micro Focus - you can delete it manually.

Copyright and Disclaimer
©

Copyright 2019 Micro Focus or one of its affiliates.

The only warranties for this product and any associated updates or services are those that may be
described in express warranty statements accompanying the product or in an applicable license agreement
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you have entered into. Nothing in this document should be construed as creating any warranty for a
product, updates, or services. The information contained in this document is subject to change without
notice and is provided "AS IS" without any express or implied warranties or conditions. Micro Focus shall
not be liable for any technical or other errors or omissions in this document. Please see the product's
applicable end user license agreement for details regarding the license terms and conditions, warranties,
and limitations of liability.
Any links to third-party websites take you outside Micro Focus websites, and Micro Focus has no control
over and is not responsible for information on third party sites.
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